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What is Agilent Mass Profiler Professional?

Agilent Mass Profiler Professional (MPP) software is a powerful 
chemometrics platform designed to exploit the high information 
content of mass spectra (MS) data and can be used in any MS-based 
differential analysis to determine relationships among two or more 
sample groups and variables. MPP provides advanced statistical 
analysis and visualization tools for GC/MS, LC/MS, CE/MS, ICP-MS, 
and NMR data analysis. MPP also integrates smoothly with Agilent 
MassHunter Workstation, Spectrum Mill and ChemStation software 
and is the only platform that provides integrated identification/ 
annotation of compounds and integrated pathway analysis for 
metabolomic and proteomic studies. The system also enables 
Automated Sample Class Prediction that revolutionizes mass 
spectrometer-based qualitative analysis of unknown samples in 
many applications. MPP is ideally suited for applications 
characterized by complex sample matrices such as metabolomics, 
proteomics, natural products, food, beverages, flavors, fragrances, 
and environmental analyses. 

How do I get started with Mass Profiler Professional?

MPP comes preloaded with a demonstration experiment to show 
you the functionality of the product. A project called “Malaria” 
contains an experiment called “Malaria LCMS ESI+ pH 7.” You are 
encouraged to explore this demonstration project to get to know 
Mass Profiler Professional. Use the familiarization tutorial to create 
your first project and experiment with the software.
Agilent Technologies



Familiarization Tutorial: How do I do a new analysis?

The steps of the familiarization tutorial are (1) Create a new project and 
experiment for your data, (2) Import and organize your data, (3) Perform your 
initial differential analysis, (4) Use MassHunter ID Browser to identify your 
compounds, and (5) Save your project

Exercise 1. Create a new project and experiment for your data

An easy way to start using the MPP software is to recreate the sample experiment 
from the demonstration project. The original Malaria Demo data you need is 
provided with the MPP installation. The data files are located in named folders 
within the main installation folder, usually found in C:\Program Files\Agilent\ 
MassHunter\Workstation\Mass Profiler Professional\samples (Windows 7).

A new project and experiment is created through four sequential dialog boxes: (1) 
Startup, (2) Create New Project, (3) Experiment Selection, and (4) New 
Experiment. Follow the steps below to create a new experiment with the Malaria 
Demo data.

Steps Detailed Instructions Comments

1 Start Mass Profiler Professional.

2 In the Startup dialog box, open a 
recent project or create a new 
project.

If you want to use the Malaria project:
a Click Open recent project.
b Select Malaria from the Select recent 

project list.
c Click OK.

• The Startup dialog box helps you 
quickly set up a new project or 
continue your analysis with a 
previous project.

• Open recent project opens the 
project and experiment(s) that are 
stored in the project.

• A project is a “container” for a 
collection of experiments; each 
experiment contains your samples, 
interpretations, and analyses. A 
project can have multiple 
experiments on different sample 
types and organisms.
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d Select an operation from the 
Workflow Browser to continue 
analyzing the Malaria Demo project.

If you instead want to create a new 
project, click Create new project and go 
to Step 3, otherwise proceed to Exercise 4 
on page 21.

• The Workflow Browser is found 
along the right sidebar and is 
organized in groups of operations.

3 In the Create New Project dialog 
box, enter your project information.

a Type Malaria Demo 
Familiarization in Name.

b Type descriptive information in Notes.
c Click OK.

• The project name and notes may be 
viewed and edited at any time using 
the Project Inspector by clicking 
Project > Inspect Project from the 
menu bar.

Steps Detailed Instructions Comments
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4 In the Experiment Selection 
Dialog dialog box, create a new 
experiment.

a Click Create new experiment.
b Click OK.

• If you click Open existing 
experiment, you are prompted for 
the experiment to add to the 
project. This is the same as clicking 
the Add experiment button .

5 In the New Experiment dialog box, 
enter and select information that 
guides your experiment creation.

a Type a descriptive name for the 
experiment in Experiment name.

b Select Mass Profiler Professional for 
Analysis type.

c Select Unidentified for the Experiment 
type.

d Select Analysis: Significance Testing 
and Fold Change for Workflow type.

e Type descriptive information in 
Experiment notes.

f Click OK.

• You may also create a new 
experiment from the Menu bar, 
click Project > New Experiment, or 
from the Toolbar, click the New 
experiment button .

• Experiment type determines how 
Mass Profiler Professional 
manages the data.

• You select Unidentified when the 
compounds have only been 
identified by their molecular 
features of neutral mass and 
retention time.

• You select Identified when the 
compounds have been identified by 
compound, formula, and/or CAS 
number.

• You select Combined (Identified + 
Unidentified) when you are unsure 
if the data has been identified in full 
or in part, or when MassHunter 
Qualitative Analysis has been 
previously used to identify some of 
the compound features.

Steps Detailed Instructions Comments
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Exercise 2. Import and organize your data

After you set up a project and create an experiment, the MS Experiment Creation 
Wizard immediately guides you through the necessary steps to organize your 
experiment, import your data, define your experiment variables, and prepare your 
data for analysis. The MS Experiment Creation Wizard flow diagram is 
illustrated in Figure 1. The data preparation includes grouping, filtering, 
alignment, normalizing, and baselining.

Figure 1 MS Experiment Creation Wizard

Steps Detailed Instructions Comments

1 Select the data source in the MS 
Experiment Creation Wizard (Step 
1 of 11).

a Click MassHunter Qual and select 
Homo sapiens for the Organism if you 
are using the Malaria Demo data set.

b Click Next.

• If you are using your own data set, 
click the source of your sample 
files, and select the Organism of 
the sample files or select None.

• Note that selecting an Organism is 
most important when you use the 
Pathway Analysis features of MPP.
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2 Select the sample data to import in 
the MS Experiment Creation 
Wizard (Step 2 of 11).

a Click Select Data Files to display the 
file selection dialog box.

b Select all of the .cef files you want to 
import into the experiment. The 
example Malaria data files are:
• 1-1_pH7_pos_01.cef
• 1-2_pH7_pos_01.cef
• 1-3_pH7_pos_01.cef
• 1-4_pH7_pos_01.cef
• 3-1_pH7_pos_01.cef
• 3-2_pH7_pos_01.cef
• 3-3_pH7_pos_01.cef
• 3-4_pH7_pos_01.cef

c Click Open to load the selected files.
d Click Next.

• Note: The Open dialog likely 
already points to the samples 
directory in the main Mass Profiler 
Professional installation directory, 
but if not, browse to C:\Program 
Files\Agilent\MassHunter\ 
Workstation\Mass Profiler 
Professional\samples\Malaria 
Demo.

• A progress indicator is displayed 
while the files are being loaded into 
MPP.

3 Review and order the selected files 
that you are importing in the MS 
Experiment Creation Wizard (Step 
5 of 11).

a Review the order of your samples. The 
order does not need to be changed 
unless an entry is out of sequence.

b Click Next.

• Note: This step presents you with 
the only opportunity you have to 
reorder your samples.

• The sample order shown in this 
step is used in subsequent views 
where the results are organized by 
sample.

Steps Detailed Instructions Comments
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4 Define the sample grouping with 
respect to the independent 
variables and the replicate 
structure of your experiment in the 
MS Experiment Creation Wizard 
(Step 6 of 11).

a Click Add Parameter.

b Type a name for your Parameter name 
in the Add/Edit Experiment 
Parameter dialog box. Type 
Infection for the Malaria Demo.

c Click your replicate Samples that 
share the same first parameter value in 
your data. For example:
• 1-1_pH7_pos_01
• 1-2_pH7_pos_01
• 1-3_pH7_pos_01
• 1-4_pH7_pos_01

d Select the Parameter type for your 
grouping. Non-Numeric is selected for 
the Malaria Demo.

e Click Assign Value.

• In Experiment Grouping, samples 
with the same parameter values are 
treated as replicates.

• For the Malaria Demo samples you 
specify which files contain data 
from infected samples and which 
contain data from uninfected 
samples.

• An independent variable is an 
essential element, constituent, 
attribute, or quality in a data set 
that is deliberately controlled in 
your experiment. An independent 
variable is referred to as a 
parameter and is assigned a 
parameter name.

• The attribute values within an 
independent variable are referred to 
as parameter values. Samples with 
the same parameter value.

• Parameter Type options:
• Select Non-Numeric if the 

grouping is not a quantitative 
value. 

• Select Numeric if the grouping 
value is quantitative or a value 
that reflects a degree of 
proportionality among the 
samples with respect to an 
independent variable. A numeric 
parameter type allows some 
data plots to be scaled by the 
parameter values.

Steps Detailed Instructions Comments
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f Type the value for your first grouping in 
the Assign Value dialog box. For the 
Malaria Demo type Not Infected.

g Click OK.

h Click your replicate Samples that 
share the same second parameter 
value in your data. For example:
• 3-1_pH7_pos_01
• 3-2_pH7_pos_01
• 3-3_pH7_pos_01
• 3-4_pH7_pos_01

i Click Assign Value.

j Type the value for your second 
grouping in the Assign Value dialog 
box. For the Malaria data type 
Infected.

k Click OK.

l Review your entries and grouping 
assignment accuracy in the Add/Edit 
Experiment Parameter dialog box.

m Click OK when the grouping for this 
parameter name is complete.

• In the Malaria Demo example the 
samples are assigned parameter 
values representing the Infection 
parameter name.

• The highlighted samples are 
assigned the value typed in the 
Assign Value dialog box.

• You may change the value of any 
sample, or group of samples; 
highlight the sample and click 
Assign Value or Clear.

Steps Detailed Instructions Comments
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n Click Next when you have completed 
your experiment grouping.

• You can save your experiment 
grouping in a tab separated value 
(TSV) file by using the Save 
experiment parameters to file 
button .

• You can view, edit, and create TSV 
files using Microsoft Excel or 
Windows Notepad.

• By using the Load experiment 
parameters from file button  
you can quickly apply a previously 
created or saved experiment 
grouping.

• Note: You may also add grouping or 
change your grouping during the 
Analysis: Significance Testing and 
Fold Change Wizard and at any 
time thereafter.

Steps Detailed Instructions Comments
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5 Select and enter the data filter 
parameters in the MS Experiment 
Creation Wizard (Step 7 of 11).

a Mark the Minimum absolute 
abundance check box under 
Abundance filtering.

b Type a value of 5000 counts.
c Clear the Limit to the largest and 

Minimum relative abundance check 
boxes.

d Mark the Use all available data check 
box under Retention time filtering.

e Clear the Use all available data check 
box and type 50 for Min Mass, and 
type 1000 for Max Mass under Mass 
filtering.

f Click Minimum number of ions and 
type 2 for Minimum number of ions 
under Number of ions.

g Click Multiple charge states 
forbidden under Charge states.

h Click Next.

• Filtering during the data import 
process may be used to reject 
low-intensity data or restrict the 
mass spectral range of your data.

• In Find Compounds by Formula 
(FbF) generated data files the term 
abundance actually refers to the 
feature volume. Whereas, in Find 
Compounds by Molecular Feature 
(MFE) generated data files the term 
abundance actually refers to the 
feature chromatographic area.

• Filtering by mass may improve your 
statistical analysis by rejecting 
masses that are not significant to 
the experiment.

• Filtering works with both GC/MS 
and LC/MS data.

Steps Detailed Instructions Comments
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6 Select and enter the retention time 
and mass alignment parameters in 
the MS Experiment Creation 
Wizard (Step 8 of 11).

a Clear the Perform RT Correction check 
box under Retention time Correction.

b Type 0.1 % and 0.15 min for RT 
Window under Compound alignment.

c Type 5.0 ppm and 2.0 mDa for Mass 
Window.

d Click Next.

• Alignment parameters are used by 
MPP to align and group compounds 
by similar mass and retention time 
across multiple sample files. The 
values you enter depend on your 
experimental conditions and the 
resolution of your MS instrument.

• In general, a larger retention time 
shift may be used to compensate 
for less than ideal chromatography 
and a smaller mass window may be 
used for higher resolution mass 
spectrometers.

• It is recommended to inspect the 
quality of your sample data to 
determine the best values for your 
alignment parameters.

Steps Detailed Instructions Comments
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7 View and review the compounds 
present and absent in each sample 
in the MS Experiment Creation 
Wizard (Step 9 of 11).

a Clear the Export For Recursion check 
box.

b Click Next.

• The unidentified compounds are 
aligned, and MPP displays 
summary data from the alignment.

• The Compound Frequency chart 
and table report the number of 
common entities that appear in 
your samples (i.e., there are 474 
entities that appear in all 8 
samples, and 1283 entities that 
appear in only 1 sample - “one-hit 
wonders”). The percent columns 
show you abundance distribution of 
the identical entities normalized to 
the most abundant common entity.

• If most of the “one-hit wonders” 
have a low relative abundance your 
sample data alignment is likely 
good. If the “one-hit wonders” have 
a high relative abundance (i.e., in 
the 30-100% column) then you may 
need to improve your sample data 
alignment.

• In the Mass vs. RT table, replicate 
samples are expected to have a 
similar number of compounds 
present and absent. 

• Any part of the sample summary 
may be exported; right-click on 
that part of the summary. Click 
Export As, and click the image type. 
The option Image allows you to 
enter the image file location, file 
name, image size, and resolution to 
meet your publication 
requirements.

Steps Detailed Instructions Comments
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8 Select whether to normalize the 
data to reduce the variability 
caused by sample preparation and 
instrument response in the MS 
Experiment Creation Wizard (Step 
10 of 11).

a Select None for the Normalization 
Algorithm in the Normalization tab.

b Clear the Use External Scalar check 
box in the External Scalar tab.

c Click Next.

• You may use normalization and 
external scalar techniques to 
reduce the variability caused by 
sample preparation and instrument 
response in your data.

Steps Detailed Instructions Comments
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9 Select whether to compare 
features in each sample to the 
response of the features across 
multiple samples in the MS 
Experiment Creation Wizard (Step 
11 of 11).

a Click Baseline to ____ of all samples.
b Select median for the Baseline to 

____ of all samples.
a Click Finish.

• There are four baselining options:

• None: Recommended if only a few 
features in the samples exist.

• Z-Transform: Recommended if the 
data sets are very dense, i.e., with 
data where very few instances of 
compounds are absent from any 
sample, such as a quantitation data 
set from recursion.

• Baseline to ____ of all samples: 
The abundance for each compound 
is normalized to its selected 
statistical abundance across all of 
the samples. This has the effect of 
reducing the weight of very large 
and very small compound features 
on later statistical analyses. 

• Baseline to ____ of control 
samples: The abundance for each 
compound is normalized to its 
selected statistical abundance 
across just the samples selected as 
the control samples. This has the 
effect of weighting the compound 
features to a known value that is 
considered to be normal in the 
population while reducing the 
effect of large and small compound 
features.

10 Continue to improve the quality of 
your results and produce an initial 
differential expression for your 
analysis.

Because you chose Analysis: 
Significance Testing and Fold Change for 
Workflow type in the New Experiment 
dialog box you are immediately directed to 
the next exercise.

• If you chose Data Import Wizard 
for Workflow type in the New 
Experiment dialog box you are 
done creating your experiment and 
can use the operations available in 
the Workflow Browser.

Steps Detailed Instructions Comments
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Exercise 3. Perform your initial differential analysis

The Significance Testing and Fold Change Wizard guides you through the steps 
necessary to enter parameters and values that improve the quality of your results 
and produce an initial differential expression for your analysis. The Significance 
Testing and Fold Change Wizard flow diagram is illustrated in Figure 2.

Figure 2 Analysis: Significance Testing and Fold Change Wizard

Steps Detailed Instructions Comments

1 Summary Report (Step 1 of 8): 
Review your data in the Summary 
Report workflow step.

a Verify that you see the Analysis: 
Significance Testing and Fold Change 
Wizard as shown below.

b Click Next.

• The Analysis: Significance Testing 
and Fold Change Wizard shows a 
profile plot and a series of steps to 
finish the experiment setup and 
your initial analysis. The current 
step is highlighted.

• You do not enter analysis 
parameters at this time. You may 
review the data, change the plot 
view, export selected data, or 
export the plot to a file by a click or 
right-click at desired features 
available on the plot. 
MPP Familiarization Guide 15



2 Experiment Grouping (Step 2 of 
8): Enter the sample grouping with 
respect to the independent 
variables and the replicate 
structure of your experiment in the 
Experiment Grouping workflow 
step.

a Verify that your Experiment Grouping 
looks like the example below.

b Click Next.

• In Experiment Grouping, samples 
with the same parameter values are 
treated as replicates.

• In the Malaria Demo samples you 
specify which files contain data 
from infected samples and which 
contain data from uninfected 
samples.

• If you are using your own data set, 
click Add Parameter and set up a 
parameter and enter the parameter 
values for each data file and return 
to this display.

3 Filter Flags (Step 3 of 8): Enter 
values that filter entities in your 
samples based on the quality of 
their presence in specified samples 
and conditions in the Filter Flags 
workflow step.

a Review your data, change the plot 
view, export selected data, or export 
the plot to a file.

b Click Re-run Filter to enter parameters 
in the Filter Parameters dialog box.

c Mark the Present and Marginal check 
boxes.

d Clear the Absent check box.
e Click at least ___ out of X samples 

have acceptable values and type 2 in 
the entry box. By setting this 
parameter to a value of two or more, 
“one-hit wonders” are filtered.

f Click OK.

• A flag is used to denote the quality 
of an entity within a sample. A flag 
indicates if the entity was detected 
in each sample as follows: Present 
means the entity was detected, 
Absent means the entity was not 
detected, and Marginal means the 
signal for the entity was saturated.

• This filter removes irreproducible 
entities from further consideration 
as you continue your analysis.

• A major objective of Filter Flags is 
to remove “one-hit wonders” from 
further consideration. A “one-hit 
wonder” is an entity that appears in 
only one sample, is absent from the 
replicate samples, and does not 
provide any utility for statistical 
analysis.

Steps Detailed Instructions Comments
16 MPP Familiarization Guide



g Review the profile plot and repeat the 
Re-run Filter until you obtain the best 
results for your experiment.

h Click Next.

4 Filter by Frequency (Step 4 of 8): 
Enter values that filter the 
remaining entities in your samples 
based on their frequency of 
occurrence among the samples 
and conditions in the Filter by 
Frequency workflow step.

a Review your data, change the plot 
view, export selected data, or export 
the plot to a file.

b Click Re-run Filter to enter parameters 
in the Filter Parameters dialog box.

c Type 100 in the Retain entities that 
appear in at least box.

d Click of samples in at least one 
condition.

e Click OK.

• Filter Frequency allows you to filter 
the input data based upon the 
frequency with which any 
compound appears in each sample 
in the experiment. The filter is 
specified by typing the minimum 
percentage and selecting the 
applicable condition.

Steps Detailed Instructions Comments
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f Review the profile plot and repeat the 
Re-run Filter until you obtain the best 
results for your experiment.

g Click Next.

5 QC on samples (Step 5 of 8): 
Assess the sample quality of your 
experiment using the QC on 
samples workflow step.

a Review your data, change the plot 
view, export selected data, or export 
the plot to a file.

b Click Next.

Steps Detailed Instructions Comments
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6 Significance Analysis (Step 6 of 
8): Assess the differential 
significance and fold change of 
your samples using the 
Significance Analysis workflow 
step.

a Review your data, change the plot 
view, export selected data, or export 
the plot to a file.

b Move the p-value cut-off slider or type 
a value to make adjustments. The 
default value is 0.05.

c Move the Fold change cut-off slider or 
type a value to make adjustments. The 
default value is 2.0.

d Click Next.

• In Significance Analysis, entities 
are filtered based on their p-values 
calculated from statistical analysis.

• The entities that satisfy the 
Significance Analysis are passed 
on for the Fold Change Analysis.

• MPP shows the fold change of the 
abundance value for each 
compound across the various 
samples in the experiment.

• Set the fold change filter so 
that you focus on the 
compounds that have intensity 
values that are most 
significant among the samples 
in the experiment.

• The Significance Analysis 
wizard page allows you to 
adjust the cutoff values for 
either the p-value or fold 
change.

7 Significance Analysis (Step 7 of 
8): Because Fold Change was 
included in the prior step (Step 6 of 
8), this separate Fold Change step 
is skipped.

• Fold Change is included in Step 6 of 
11 because the significance 
analysis is a t-test due to the data 
consisting of one parameter with 
two conditions (parameter values).

Steps Detailed Instructions Comments
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8 Significance Analysis (Step 8 of 
8): Identify the entities in your 
experiment using the IDBrowser 
Identification workflow step.

a Review the table of compounds that 
remain after all of the previous filtering 
steps.

b Click IDBrowser Identification.
c Continue with the next exercise.

• The compounds remaining are also 
referred to as entities.

• The compounds are identified only 
by their mass and retention time in 
the Compound column of the table.

• ID Browser helps you identify the 
compounds in the table.

Steps Detailed Instructions Comments
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Exercise 4. Use MassHunter ID Browser to identify your compounds

Identify the compounds that remain after applying the filtering steps of the 
Significance Testing and Fold Change Wizard.

Steps Detailed Instructions Comments

1 Set up your identification method 
in the first dialog box of the 
Compound Identification Wizard.

a Review the identification method.
b Click Next.

• When you launch ID Browser it 
receives the list of entities (also 
referred to as compounds) from the 
last step of the previous exercise.

• If you started ID Browser from the 
Workflow Browser, click Run ID 
Browser on the ID Browser toolbar.

2 Set the parameters for your 
identification technique in the 
second dialog box of the 
Compound Identification Wizard.

a Review the identification techniques.
b Click Finish.

• ID Browser provides you with many 
ways to adjust the identification 
algorithm.

• Click Help to get a full description 
of the options and features 
available to set up your 
identification technique.
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3 Review and adjust your 
identifications.

a Review the identification technique.
b Click Finish.

• ID Browser shows you information 
about each identified entity and 
gives you the ability to make 
adjustments to the identifications.

4 Accept the current identifications 
and return to Mass Profiler 
Professional.

a Click Save and Return on the ID 
Browser toolbar.

• ID Browser sends all of the 
information it has generated back 
to your entity list in Mass Profiler 
Professional.

Steps Detailed Instructions Comments
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5 Examine the results in Mass 
Profiler Professional.

a Study the compounds that are now 
identified in the compound table.

b Click Finish.

• The compound column in the table 
shown in Significance Analysis 
(Step 8 of 8) is updated with your 
identifications from ID Browser.

6 Review the profile plot, the 
Analysis: Significance Testing and 
Fold Change Wizard is now 
complete.

a Review the profile plot.
b Click on any entity list in the 

Experiment Navigator to review the 
results.

• You can follow the results from your 
analysis in the hierarchical 
presentation in the Experiment 
Navigator on the left sidebar.

Steps Detailed Instructions Comments
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Exercise 5. Save your project

Save your current analysis as a TAR file for archiving, restoration of any future 
analysis to the current results, sharing the data with a collaborator, or sharing the 
data with Agilent customer support.

Steps Detailed Instructions Comments

1 Export your project to a TAR file. a Click Project > Export Project.
b Mark the check box next to the 

experiment you wish to save
c Click OK.

d Select or create the file folder.
e Type your file name in File name.
f Click Save.

g Click OK.

• You have completed creating your 
project and analyzing an 
experiment. It is recommended to 
archive your progress by exporting 
your project.
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Advanced Tasks

The operations available in the Workflow Browser provide the tools necessary for 
analyzing features from your mass spectrometry data depending upon the need 
and aim of the analysis, the experiment design, and the focus of the study. This 
helps you create different interpretations to carry out the analysis based on the 
different filtering, normalization, and standard statistical methods.

It is recommended that you follow the procedures in the Mass Profiler 
Professional Software - Application Guide for an additional level of detailed 
information to help you use MPP with your data.

The Metabolomics Discovery Workflow and Mass Profiler Professional User 
Manual provide you with techniques and explanations to perform advanced 
analysis tasks.
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BioCyc Pathway/Genome Databases

Includes BioCyc Pathway/Genome databases from the Bioinformatics Research 
Group at SRI International®, used under license.

http://www.biocyc.org/

Citation based on use of BioCyc

Users who publish research results in scientific journals based on use of data from 
the EcoCyc Pathway/Genome database should cite:

Keseler et al, Nucleic Acids Research 39:D583-90 2011. 

Users who publish research results in scientific journals based on use of data from 
most other BioCyc Pathway/Genome databases should cite:

Caspi et al, Nucleic Acids Research 40:D742-53 2012.

In some cases, BioCyc Pathway/Genome databases are described by other specific 
publications that can be found by selecting the database and then going to the 
Summary Statistics pages under the Tools menu. The resulting page sometimes 
contains a citation for that database.
26 MPP Familiarization Guide



MPP Familiarization Guide 27



Agilent Technologies

© Agilent Technologies, Inc. 2012

Revision A, November 2012

*G3835-90010*

G3835-90010

www.agilent.com

In this book

The Agilent G3835AA 
MassHunter Mass Profiler 
Professional Software - 
Familiarization Guide 
presents the functionality of 
Mass Profiler Professional 
using a “Malaria” project 
containing an experiment 
called “Malaria LCMS ESI+ pH 
7.”

Windows7® is a registered trademark of 
Microsoft Corp. in the US and/or other 
countries.
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